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BAB I 

PENGANTAR ARCGIS 

 

ArcGIS adalah perangkat lunak yang dikeluarkan oleh Environmental Systems Research 

Institute (ESRI), sebuah perusahaan yang telah lama berkecimpung di dalam bidang geospasial. ArcGIS 

adalah sebuah platform yang terdiri dari beberapa software yaitu Desktop GIS, Server GIS, Online GIS, 

ESRI Data, dan Mobile GIS 

ArcGIS Desktop hanya dapat diinstal pada sistem operasi (OS) Windows. Khusus untuk ArcGIS 

Desktop versi 10.3 hanya dapat diinstal pada OS Windows 7, Windows 8/8.1, Windows Server 

2008/2012 dan Windows 10. Pengguna OS Linux dan Mac masih belum dapat menginstal ArcGIS 

Desktop. Beberapa pengguna mencoba menggunakan emulator windows agar dapat menginstal ArcGIS 

Desktop pada Linux/Mac. Namun tentu saja masalah kompatibilitas seringkali menjadi masalah. 

Penyusun menyarankan untuk menginstal ArcGIS Desktop hanya pada OS Windows saja. 

ArcGIS Desktop merupakan pengembangan dan gabungan dari ArcView 3.x yang unggul dalam 

antarmuka visual dengan Arc/INFO versi 7 yang unggul dalam analisis. Oleh karena itu tidak 

mengherankan jika ArcGIS Desktop disebut-sebut sebagai gabungan dari ArcView 3.x dan Arc/INFO. 

ArcGIS versi pertama adalah ArcGIS 8.0 yang dirilis pada tahun 1999. ArcView dan Arc/INFO yang 

sebelumnya adalah software tersendiri dijadikan sebagai tingkatan lisensi di dalam ArcGIS Desktop. 

ArcGIS Desktop masih merupakan kumpulan software (suite) yang terdiri dari beberapa 

software tersendiri yaitu: 

1. ArcMap 

ArcMap adalah software paling utama di dalam ArcGIS Desktop karena hamper semua tahapan GIS 

seperti input, analisis dan output data spasial dapat dilakukan pada ArcMap, sama halnya dengan  

menggunakan software pemetaan lain seperti ArcView 3.x, QGIS, AutoCAD Land Desktop, dan 

sebagainya. Terdapat Meskipun demikian, banyak tugas-tugas GIS yang tidak dapat dilakukan 

menggunakan ArcMap sehingga pengguna masih perlu untuk mempelajari dan menggunakan 

software ArcGIS Desktop lain selain ArcMap. 

2. ArcCatalog 

ArcCatalog memiliki fungsi untuk pengelolaan data spasial meliputi input, konversi, dan analisis data. 

ArcCatalog dapat dianalogikan sebagai File Explorer (atau windows explorer) pada OS Windows. 

Namun karena tugasnya spesifik untuk menangani data spasial, maka fungsi pengelolaan file yang 

dimiliki oleh ArcCatalog lebih khusus dan spesifik. ArcCatalog tidak saja digunakan untuk mengelola 



 

data spasial, tetapi juga untuk melakukan analisis data. ArcCatalog biasa disandingkan dengan 

ArcMap. Biasanya ArcCatalog digunakan untuk menambahkan data ke dalam ArcMap dengan cara 

drag and drop dari ArcCatalog. 

3. ArcScene 

ArcScene berfungsi untuk visualisasi 3D, yaitu menyajikan tampilan yang perspektif, bernavigasi dan 

berinteraksi dengan data fitur 3D dan raster. Software ini biasa digunakan untuk cakupan lokal atau 

tidak terlalu luas, misalnya untuk visualisasi sebuah kota kecil, kawasan hutan, bendungan, dan 

sebagainya. 

4. ArcGlobe 

ArcGlobe adalah bagian dari ArcGIS Desktop yang ditujukan untuk eksplorasi data spasial secara 

virtual dengan ukuran dan cakupan data yang besar. Jika ArcScene menampilkan data spasial secara 

lokal, maka ArcGlobe menampilkan data spasial dalam perspektif global. ArcGlobe serupa dengan 

software Google Earth dari Google atau World Wind dari NASA. 

5. ArcReader 

ArcReader biasa digunakan jika pengguna ingin membagi project ArcMap dengan pihak lain. Pihak 

penerima project tidak perlu install ArcMap untuk dapat membuka dan melakukan eksplorasi project 

tersebut. Cukup dengan menggunakan ArcReader yang gratis, pengguna dapat melihat project 

ArcMap 

yang telah dibuat. ArcReader (dan ekstensi Publisher untuk ArcMap) memiliki beberapa fungsi ntuk 

mengatur bagaimana data yang dibagikan dalam project dapat diakses. Data spasial yang turut 

dipaketkan dan disalin dapat dikunci sehingga pengguna tidak memiliki akses penuh terhadap data 

spasial yang dibagi. 

 

1.1. Bekerja Dengan ArcMap 

Pada ArcMap Anda bekerja dalam suatu map project dengan file extension *.mxd. Sebelum lebih 

jauh kita bekerja menggunakan ArcMap ada baiknya mengenal terlebih dahulu antarmuka ArcMap, 

kemudian dilanjutkan dengan penambahan data spasial pada ArcMap, memeriksa atribut datanya , 

bagaimana navigasi peta pada ArcMap, dan melakukan pengelolaan pada layer. 

1.1.1. Tampilan Antarmuka (User Interface) ArcMap 

Graphical User Interface (GUI) atau Grafik Antarmuka Pengguna, yaitu desain antarmuka yang 

digunakan untuk berinteraksi dengan pengguna, contoh: desain menu dan icon dari software, desain ini 

memiliki fungsi khsusus di masing – masing menu / icon. Berikut ini tampilan antarmuka pada ArcMap 



 

 

Berikut ini merupakan keterangan fungsi dan kegunaan dari user interface yang ada pada ArcMap: 

Nomor User Interface Keterangan 

1 Menu Merupakan sekumpulan perintah berbasis teks/ kata untuk melakukan 

tugas-tugas tertentu pada ArcMap.  

2 Toolbar  Sekumpulan perintah berbasis ikon/ tombol untuk melakukan tugas - 

tugas tertentu. Untuk mengaktifkan /menonaktifkan tools toolbar klik 

kanan pada toolbar lalu pilih Tools yang ingin diaktifkan. 

3 Table of 

Content 

Menampilkan daftar semua layer yang digunakan pada project ArcMap 

yang sedang dikerjakan. 

4 Map Canvas Menampilkan layer atau peta pada project yang sedang dikerjakan pada 

ArcMap. 

5 Catalog Memiliki fungsi mirip ArcCatalog, namun dengan kapabilitas lebih 

terbatas. 

6 Toggle Mengganti dari Data View ke Layout View 

7 Coordinate Bar Menampilkan koordinat kursor yang ditunjuk pada Map Canvas 
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1.1.2. Menambah Data Spasial 

Langkah pertama yang harus dilakukan untuk memulai membuat peta sederhana dengan ArcMap 

adalah menambah data ke dalam map project. Adapun langkah- langkahnya sebagai berikut: 

1. Klik tombol Connect to Folder  pada Panel Catalog untuk memasukan folder yang berisi data 

spasial 

2. Kemudian akan muncul kotak dialog yang membolehkan Anda untuk memilih folder yang akan 

ditambahkan ke dalam Panel Catalog. Klik OK. Pada contoh ini kita akan memasukkan folder data 

spasial provinsi Banten yaitu folder 28_Banten.  

3. Kemudian akan muncul folder 28_Banten pada Panel Catalog. 

4. Pada folder 28_Banten terdapat file 28_Banten.shp yang merupakan file berisi geodata provinsi 

Banten. 

5. Drag and drop file 28_Banten.shp ke dalam map canvas. Anda sekarang dapat melihat layer baru 

pada map canvas dan di daftar layer. 



 

6. Untuk merubah warna peta, klik kanan pada layer kemudian pilih Properties > Symbology. 

7. Pilih Single symbol untuk merubah warna peta secara keseluruhan. 

 

8. Klik warna pada kolom Symbol, maka akan muncul kotak dialog Symbol selector. Pilih warna yang 

diinginkan dengan merubah warna pada Fill Color. Anda juga bisa merubah warna batas dengan 

merubah warna pada Outline Color. 

9. Klik OK untuk memproses perubahan warna pada peta. 

 

 

 

 



 

 

1.1.3. Memeriksa Atribut Data 

Untuk melihat atribut dari data yang kita masukan bisa didapatkan melalui Identify Features, 

adapun langkahnya adalah sebagai berikut: 

1. Klik kanan pada salah satu bagian peta dimana saja pada Map Canvas, kemudian pilih Identify.  

2. Muncul kotak dialog yang menampilkan Attribute Feature dari bagian peta tersebut. 

 
1.1.4. Navigasi Peta 

Menavigasikan peta pada canvas ArcMap Anda dapat menggunakan “Map Navigation Toolbar” 

yang terdiri dari beberapa tombol yang masing-masing memiliki fungsi, yaitu: 

Icon Nama Icon Fungsi 

 
Zoom in Digunakan untuk melakukan perbesaran pada peta, dengan cara 

membuat membuat kotak di area yang ingin di perbesar. 

 
Zoom Out Digunakan untuk memperkecil tampilan pada peta, klik pada peta 

untuk memperkecil. 



 

Icon Nama Icon Fungsi 

 

Pan Digunakan untuk menggeser peta atau menggerakannya pada ke 

tampilan yang kita inginkan. ini dilakukan dengan cara menahan 

tombol mouse sebelah kiri, lalu gerakkan mouse anda maka seketika 

peta anda juga akan bergerak. 

 
Full Extent Digunakan untuk zoom ke semua tampilan Layer, sehingga semua 

layer nampak pada map canvas. 

 
Fixed Zoom In Zoom in ke titik tengah data frame dengan besaran zoom 125% dari 

zoom semula 

 
Fixed Zoom Out Zoom out ke titik tengah data frame dengan besaran zoom 80% dari 

zoom semula 

 
Go Back to Previous 

Extent 
Digunakan untuk kembali ke navigasi yang dilakukan sebelumnya. 

 
Go Back to Next 

Extent 

Digunakan untuk menuju navigasi yang dilakukan sebelum menekan 

Go Back to Previous Extent. 

 

1.1.5. Mengelola Layer 

Layer yang digunakan dalam proses pembuatan peta dapat kita kelola agar sesuai dengan yang 

Anda inginkan dan dapat memberikan informasi dari peta yang kita tampilkan. Pengelolaan layer yang 

dimaksudkan adalah mengelola layer pada Table of Content. Table of Content merupakan daftar layer, 

file atau apapun yang dimasukkan kedalam proyek ArcMap. Table of Content tidak hanya menunjukkan 

semua file yang kita buka, tetapi juga menjelaskan susunan urutan yang ditampilkan pada Map Canvas. 

Terdapat beberapa fitur yang berfungsi untuk mengelola layer pada project ArcMap, antara lain: 

1. Membuat Grup Layer 

• Berfungsi memudahkan dalam mengidentifikasi susunan layer pada project ArcMap sesuai dengan 

kebutuhan klasifikasi sehingga susunan layer terlihat lebih rapih pada Layer Panel. 

• Tahan tombol “Ctrl” pada keyboard Anda dan meng-klik pada layer yang berbeda, kemudian klik 

kanan pada salah satu layer, lalu pilih Group. Muncul layer baru dengan nama “New Group Layer” 



 

• Untuk membatalkan Group, anda bisa lakukan klik kanan pada grup lalu pilih Ungroup. Maka layer 

akan kembali seperti semula 

2. Mematikan / Mengaktifkan Layer 

• Untuk dapat mematikan dan mengaktifkan layer dengan cara klik pada kotak di sebelah nama 

layer pada Table of Content. Layer yang memiliki tanda  menunjukkan layer tersebut sedang 

aktif. Sebaliknya layer dengan tanda  menunjukkan layer tersebut tidak aktif. 

• Peta yang ditampilkan pada Map Canvas adalah peta dari layer yang sedang aktif. 

3. Mengubah Susunan Layer 

• Mengubah susunan layer digunakan untuk mengubah urutan layer. Susunan layer sangat 

berpengaruh pada keterlihatan pada peta. Pada saat data ditambahkan pada layer, data yang 

ditambah lebih dulu posisinya secara default akan berada pada susunan paling bawah pada 

“Table of Content”. Sedangkan layer paling atas merupakan tampilan terluar dari peta yang 

ditampilkan pada Map Canvas. 



 

• Cara mengubah susunan layer dilakukan dengan Drag-and-Drop layer yang bersangkutan.  

4. Mengubah Nama Layer 

• Untuk mengubah nama layer dapat dilakukan dengan klik kiri pada layer yang ingin anda ubah 

Namanya, lalu tekan F2 pada keyboard. 

• Ubah nama layer kemudian tekan enter 

• Perubahan nama pada layer tidak akan berpengaruh pada file data yang bersangkutan, karena 

proses ini hanya mengubah display pada layer. 

5. Menghapus Layer 

• Untuk mengubah nama layer dapat dilakukan dengan klik kanan pada layer yang ingin anda 

hapus lalu pilih Remove.  

 

 

  



 

BAB II 

DATA ATRIBUT 

 

Data yang dapat ditampilkan pada SIG adalah data spasial dimana data spasial adalah data 

yang berorientasi geografis, memiliki koordinat sebagai dasar referensi dan memiliki informasi penting 

yaitu  

1. Informasi lokasi (spasial), berkaitan dengan suatu koordinat baik koordinat geografi (lintang dan 

bujur) dan koordinat XYZ. 

2. Informasi deskriptif (atribut) atau informasi non spasial, suatu lokasi yang memiliki beberapa 

keterangan yang berkaitan dengannya, contohnya : populasi, luasan, dan sebagainya. 

Atribut data SIG dapat dikatakan sebagai data terstruktur atau informasi mengenai setiap data 

spasial. Tutorial ini menunjukkan bagaimana membuat, mengisi, menghapus, dan mengubah data 

attribute. Selain itu dipelajari juga bagaimana cara memperlihatkan dan menambah data attribute 

dengan melakukan Query standard di ArcMap. Terkait dengan penambahan informasi pada attribute 

dapat dilakukan dengan Tools join table. 

 

2.1. Eksplorasi Data Attribute 

Untuk melihat semua data yang tersedia, Anda dapat melakukan langkah berikut, 

1. Buka tabel atribut dengan cara klik kanan pada layer > Open Attribute Table. 

 
2. Kemudian akan muncul tabel atribut dari layer yang anda pilih. Di bagian atas pada kolom atribut, 

Data 
Attribute 

Tools Data 
Attribute 



 

Anda dapat melihat atribut dari fitur yang terkandung pada layer. 

Tools yang terdapat didalam attribute table yang penting anda ketahui antara lain, 

Icon Nama Icon Fungsi 

 Table options Tombol untuk memilih tools yang akan digunakan dalam mengedit table 

 Select by Attribute Membuka dialog untuk melakukan seleksi data (query data) 

 Switch Selection Melakukan blok kebalikan dari data yang sudah terpilih 

 Clear Selection Menghilangkan blok data record yang terpilih 

 Zoom to Selected Memperbesar peta pada fitur yang terpilih 

 Select all Melakukan blok seluruh record data 

 

2.2. Editing Tabel Data Attribute 

Dalam memasukkan atau rekonstruksi data atribut, baik dalam file data vector baru ataupun 

memanfaatkan data vector yang sudah ada, sering kali pengguna membutuhkan kolom (field) tambahan 

untuk menambahkan informasi atribut. Selain menambahkan, untuk informasi yang tidak diperlukan 

dalam data vector yang anda miliki, kolom dapat dihapus.  

2.2.1. Menambah Kolom Tabel Attribute 

1. Aktifkan editing toolbar terlebih dahulu dengan klik kanan pada toolbar area, pilih / centang Editor. 

Editor toolbar akan muncul pada toolbar area. 

2. Pada Editor Toolbar klik Editor > Start Editing untuk mengaktifkan mode editing 

3. Buka tabel atribut dengan cara klik kanan pada layer > Open Attribute Table. 

4. Klik tombol Table Options (  ) lalu pilih Add Field… 

5. Muncul kotak dialog add field. Isikan nama kolom, tipe kolom, 

dan Panjang isian kolom (precision). Nama kolom hanya 

diperbolehkan terdiri dari huruf dan angka saja, panjangnya pun 

dibatasi hanya 10 huruf. 

NOTE :  Jenis (Type) field dalam ARCGIS antara lain: 

• Short Integer: Jenis untuk seluruh angka dengan digit 

pendek. Biasanya untuk kode dan lain sebagainya. 



 

• Long Integer: Jenis untuk seluruh angka dengan digit panjang.  

• Float: Angka dengan nilai pecahan decimal dengan digit pendek. 

• Double: Angka dengan nilai pecahan decimal dengan digit panjang. 

• Text: seluruh karakter termasuk alphanumeric. Biasanya untuk nama dan lain sebagainya 

• Date: untuk menyimpan waktu dalam hal ini  

6. Klik OK untuk membuat field baru. 

7. Isi data atribut dengan cara mengetik di kolom yang dituju, sama seperti anda bekerja pada tabel 

spreadsheet (excel) 

 
8. Setelah selesai, tutup jendela table attribute lalu klik Editor > Stop Editing untuk mematikan mode 

editing. 

9. Simpan perubahan 

2.2.2. Menghapus Kolom Tabel Attribute 

1. Buka tabel atribut dengan cara klik kanan pada layer > Open Attribute Table. 

2. Klik kanan pada header kolom atribut yang akan dihapus, pilih Delete Field lalu OK. Delete Field tidak 

akan aktif apabila mode editing sedang aktif. Pastikan matikan mode editing terlebih dahulu sebelum 



 

menghapus kolom. 

3. Jika ingin menghapus beberapa field dapat dengan menekan tombol Ctrl pada keyboard kemudian 

klik kiri untuk memilih field mana saja yang akan dihapus. 

 

2.3. Join Tabel Attribute 

Menggabungkan (Join) tabel atribut berfungsi mengintegrasikan data tabular ke dalam data spasial. 

informasi pada table attribute dapat ditambah tanpa melakukan input secara manual sehingga proses 

yang dilakukan dalam pendataan informasi dapat dilakukan lebih cepat. Dengan menggunakan fungsi 

Join pada ARCGIS kita dapat menggabungkan arsip data tabular ke dalam sebuah shapefile. 

Format data tabular yang dapat diintegrasikan dengan menu standar ArcMap adalah Comma 

Delimited (*.csv) atau Text Delimited (*.txt), namun dalam keseharian data tabular yang umumnya 

dipakai berasal dari Microsoft Excel dengan format (*.xls) atau (*.xlsx). Dengan menggunakan Plugin 

Spreadsheet Layers, data tabular dengan format (*.xls / *.xlsx) dapat digunakan untuk dimuat dalam 

ARCGIS. Hal pertama yang perlu disiapkan adalah dengan menginstall Access Database Engine terlebih 

dahulu.   

Access Database Engine berfungsi untuk memfasilitasi transfer data antara system file Microsoft 

office dengan aplikasi non-Microsoft. Untuk mendapatkan Access Database Engine, Anda bisa 

mengunduh pada laman situs https://www.microsoft.com/en-us/download/details.aspx?id=23734. 

Setelah selesai diunduh, install sesuai dengan instruksi.  

3.3.1. Input Data Spreadsheet ke dalam ArcMap 

1. Siapkan data dalam format excel (*.xlx), dalam contoh ini data yang digunakan adalah Jumlah Kasus 

Difteri dan Cakupan Imunisasi DPT3 Provinsi Banten tahun 2017. Simpan ke dalam folder yang 

terhubung pada Panel Catalog. Pada contoh ini adalah folder 28_Banten 

https://www.microsoft.com/en-us/download/details.aspx?id=23734


 

 
2. Explore file Difteri Banten.xlsx, Anda akan temukan Sheet1$ dimana berisi data yang telah disiapkan 

sebelumnya. Drag and drop file Sheet1$. ke dalam map canvas. Anda sekarang dapat melihat layer 

baru di daftar layer Table of Content. 

3. Rename layer Sheet1$ dengan Data Difteri DPT3 Banten 



 

4.  Untuk melihat tabel yang sudah diinput, Klik layer Data Difteri DPT3 Banten, buka tabel atribut 

dengan cara klik klik kanan pada layer > Open Attribute Table, maka akan tampil seperti berikut. 

 

3.3.2. Join Tabel Attribute 

Untuk melakukan join tabel attribute/menggabungkan data attribute, tabel attribute sasaran atau 

tabel attribute yang akan ditambahkan harus memiliki satu kolom dengan informasi atau nilai yang 

sama, nilai tersebut dapat dikatakan sebagai Unique Value. Apabila Unique Value tidak ada maka Join 

tabel tidak dapat dilakukan. Dalam contoh ini, Unique Value adalah kode kabupaten (KODEKAB) atau 

KODELINK. 

1.  Klik kanan pada layer “28_Banten”, pilih Join and Relates > Joins… 



 

2. Pada kotak dialog Join Data, pilih pada Kolom 1 dan Kolom 3 sesuai dengan unique value dari excel 

(untuk Join field / Kolom 3) dan shapefile (untuk target layer / Kolom 1).  

3. Pada Kolom Join Options, Anda diberi pilihan untuk Keep all records (mempertahankan semua data 

di semua kolom) atau Keep only matching records (mempertahankan data hanya pada kolom yang 

memiliki kesamaan data). Biarkan dalam kondisi default apabila Anda ingin menggabung semua data. 

4. Klik OK 

5. Sekarang buka lagi tabel atribut pada layer “28_Banten”, 

anda dapat melihat kolom yang baru. 

 

3.3.3. Query Data Attribute 

Query (penelusuran) dalam GIS merupakan suatu cara untuk mencari area yang memiliki satu 

kriteria tertentu. Dengan adanya query, tabel atribut dapat disusun dan atau dipilih berdasarkan objek 

tertentu serta dapat mencari objek yang dibutuhkan. Proses pemilihan dilakukan menggunakan 

operator tertentu, baik operator aritmatik (penambahan, pengurangan, perkalian, pembagian), logical 

(OR, AND), kondisional (if, then, else), maupun perbandingan (kurang dari, lebih dari). Untuk melakukan 

query terhadap attribute data spasial, ArcMap menggunakan ekpresi seperti SQL untuk melakukan 

queries. 

Query data tabel sangat dibutuhkan untuk data vector, terlebih pada data spasial yang memiliki 

banyak feature. Data yang dipakai dalam contoh ini adalah layer/shapefile “28_Banten”. Pada shapefile 

tersebut berisi data Provinsi Banten yang sudah digabung dengan data kasus difteri dan cakupan 



 

imunisasi DPT3 pada contoh sebelumnya. Sebagai contoh kita akan mencoba mencari kabupaten 

tertentu di Provinsi Banten, adapun langkahnya sebagai berikut: 

1. Open attribute table layer “28_Banten” 

2. Untuk melakukan pemilihan/select beberapa informasi attribute yang akan digunakan, klik tombol 

Table Options (  ) lalu pilih Select By Attribute (  ), kemudian maka akan muncul jendela select 

by attributes seperti di bawah ini. 

3. Pada jendela Select By Attributes, pilih atribut yang akan Anda telusuri. 

4. Klik ganda label “28_Banten.DISTRICT” untuk memasukkan pilihan “DISTRICT” ke kolom ekspresi. 

5. Untuk melihat nilai “DISTRICT” yang ada pada peta, Klik “Get Unique Values” 

6. Pada kolom value akan muncul nama-nama nilai “DISTRICT” yang ada pada Peta 



 

 
7. Untuk praktek sekarang, kita mencoba untuk menemukan kabupaten Serang, Jadi instruksi yang 

diberikan. Klik dua kali pada DISTRICT kemudian untuk memilih/select klik tanda sama dengan “=”, 

selanjutnya pada Value cari Kabupaten Serang, klik dua kali untuk memasukkan kedalam kolom 

ekspresi. 

8. Klik “Apply” untuk memproses. Klik Close untuk menutup Jendela Select By Attributes. Jika langkah-

langkah yang dilakukan benar maka pada pada jendela Select By Attributes akan muncul seperti 

berikut. 

9. Close table attribute, Jika Anda melihat pada area bidang peta (Map Canvas), record data yang dipilih 

akan ditandai dengan outline warna biru muda. 



 

 
Contoh berikutnya kita akan mencoba mencari beberapa kabupaten tertentu di Provinsi Banten, 

langkah yang dilakukan tidak jauh berbeda dengan yang sebelumnya, hanya pada bagian formula SQL 

saja yang berbeda.  Adapun langkahnya sebagai berikut: 

1. Open attribute table layer “28_Banten” 

2. Klik tombol Table Options (  ) lalu pilih Select By Attribute (  ) 

3. Klik ganda label “28_Banten.DISTRICT” untuk memasukkan pilihan “DISTRICT” ke kolom ekspresi. 

4. Untuk melihat nilai “DISTRICT” yang ada pada peta, Klik “Get Unique Values” 

5. Untuk memilih beberapa kabupaten klik tombol In (  ) 

dilanjutkan klik tombol kurung (  ) , selanjutnya pada Value 

klik Kabupaten Lebak. Sebelum memilih kabupaten berikutnya 

beri koma, lalu selanjutnya klik Kabupaten Pandeglang.  

NOTE: Formula expression untuk mencari beberapa value 

tertentu adalah 

‘Field’ in ( ‘Value1’[spasi],[spasi]’Value2’[spasi],[spasi]’Value….’) 

6. Jika formula benar maka pada pada jendela select by expression 

akan muncul seperti berikut. 

 

 

 

 

 

 



 

7. Anda dapat melihat record data yang terseleksi (terpilih) sesuai dengan kriteria yang dibutuhkan 

dalam tabel atribut. 

 

8. Close table attribute, Jika Anda melihat pada area bidang peta (Map Canvas), record data yang dipilih 

akan ditandai dengan outline warna biru muda 

   



 

BAB III 

LABEL DAN KLASIFIKASI 

 

Kelebihan dari SIG adalah bahwa seluruh objek yang tampak pada peta juga memiliki data 

atribut. Peta dalam SIG bukan sekedar gambar. Mereka tidak hanya merepresentasikan lokasi objek, 

tetapi juga informasi tentang objek tersebut. Pada pelajaran ini kita akan menelusuri data atribut dari 

suatu objek dan memahami kegunaan dari berbagai data tersebut. 

Data atribut yang berbeda akan berguna untuk tujuan yang berbeda pula. Beberapa 

diantaranya dapat direpresentasikan langsung sebagai teks, symbol, klasifikasi dan sebagainya agar 

dapat dilihat oleh pengguna peta. Berikutnya kita akan melihat bagaimana mengolah data atribut 

sehingga pengguna dapat merepresentasikan peta. 

3.1. Labelling Attribute Data 

Label dapat ditambahkan ke dalam peta untuk menunjukkan informasi tentang objek. Suatu layer 

vektor dapat memiliki label yang berkaitan dengan layer tersebut. Label bergantung pada data atribut 

dari layer terkait. Cara untuk menambahkan label pada ArcMap adalah sebagai berikut: 

1. Klik ganda pada layer “28_Banten”, maka akan muncul halaman Layer Properties. 

2. Pilih tab Labels, kemudian klik / centang Label features in this layer 

3. Tentukan field mana yang ingin kita gunakan untuk pemberian label. Pada contoh ini kita akan 

gunakan field “DISTRICT”. 

 
4. Anda juga dapat melakukan pengaturan label dengan merubah jenis dan ukuran font, warna font, 

dan sebagainya. 

5. Klik OK, Sekarang layer “28_Banten” sudah muncul dengan label di dalamnya seperti ini: 



 

 
3.2. Klasifikasi Data 

Pemberian label adalah cara yang baik untuk mengkomunikasikan informasi seperti nama dari 

suatu tempat, namun label tidak dapat digunakan untuk semua hal. Sebagai contoh, misalnya kita ingin 

menunjukkan kabupaten mana yang memiliki performa cakupan imunisasi DPT3. Dengan menggunakan 

label saja, peta tidak dapat merepresentasikan daerah mana yang memiliki cakupan rendah, sedang, 

atau tinggi. Pada modul ini, kita akan belajar mengklasifikasi data nominal dan rasio pada peta. 

3.2.1. Klasifikasi Data Nominal 

1. Buka jendela Layer Properties dari layer yang akan diklasifikasikan, dengan cara klik ganda pada layer 

“28_Banten” 

2. Pilih tab Symbology lalu pilih kolom Categories > Unique Value 

3. Pilih pada Value Field dengan field yang akan diklasifikasikan. Pada contoh klasifikasi data nominal ini 

yang akan diklasifikasikan adalah kabupaten di Provinsi Banten. Pilih DISTRICT. 



 

4. Klik pada tombol Add All Value untuk menambahkan value yang akan diklasifikasi secara nominal. 

5. Hasil klasifikasi akan akan terlihat seperti dibawah ini. 

 
6. Ubah warna untuk tiap kabupaten dengan melakukan klik ganda pada kotak warna yang terletak di 

samping kiri sesuai dengan yang Anda inginkan. 

 

3.2.2. Klasifikasi Data Rasio 

Pada contoh sebelumnya, kita mengklasifikasikan layer dengan klasifikasi nominal dimana tipe 

klasifikasi ini digunakan ketika kategori dibuat berdasarkan nama. Berikutnya kita akan melakukan 

klasifikasi klasifikasi data atribut yang hanya memuat angka, disebut sebagai klasifikasi rasio. Pada 

contoh ini, kita akan mengklasifikasi kabupaten dengan performa cakupan imunisasi DPT3 menjadi 

kabupaten dengan cakupan rendah, sedang dan tinggi.  

1. klik ganda pada layer “28_Banten” 

2. Pilih tab Symbology lalu pilih kolom Quantities > Graduated Colors 



 

3. Pilih Value pada kolom Field dengan Cakupan DPT3 

4. Tentukan jumlah klasifikasi sesuai dengan yang diinginkan pada kolom Classes. Karena kita akan 

mengklasifikasi kabupaten dengan performa cakupan imunisasi DPT3 menjadi kabupaten dengan 

cakupan rendah, sedang dan tinggi, maka kolom Classes pilih angka 3. 

5. Ubah Range dan Label pada masing – masing kelas dengan cara klik ganda pada masing – masing 

kelas. 

6. Contoh kabupaten dengan cakupan rendah apabila cakupan imunisasi DPT3 kurang dari 80%. 

Kabupaten dengan cakupan sedang apabila cakupan imunisasi DPT3 mencapai 80% hingga kurang 

dari 95%. Sedangkan kabupaten dengan cakupan tinggi apabila cakupan imunisasi DPT3 sama dengan 

atau lebih dari 95%. Maka cakupan rendah memiliki range nilai terendah hingga 79,999999. Cakupan 

sedang memiliki range 80,000000 hingga 94,999999. Sedangkan cakupan tinggi memiliki range 

95,000000 hingga nilai tertinggi. 



 

7. Ubah warna symbol dengan Klik ganda kotak warna pada kolom symbol. Ubah warna sesuai 

keinginan. Contoh, warna symbol kabupaten dengan cakupan rendah adalah merah, warna symbol 

kabupaten dengan cakupan sedang adalah kuning, warna symbol kabupaten dengan cakupan tinggi 

adalah hijau. Klik OK. 

8. Setelah selesai merubah warna, value, dan legend, maka klasifikasi akan seperti berikut. 

9. Klik OK, warna peta akan berubah sesuai klasifikasi dan rename layer menjadi Cakupan DPT3 Banten. 

 

3.3. Membuat Titik (Point/Dot) pada Peta 

Pada contoh sebelumnya, kita telah mengklasifikasikan layer dengan klasifikasi nominal dan rasio. 

Namun, klasifikasi saja terkadang belum cukup untuk merepresentasikan sebuah peta sesuai yang 



 

diharapkan. Kita perlu mengkombinasikan data lain pada attribute table dengan peta yang sudah 

diklasifikasikan, salah satunya dengan mengkombinasikan  peta titik (point/dot) dengan peta yang sudah 

terklasifikasi. 

Biasanya peta titik (point/dot) digunakan untuk menggambarkan lokasi/tempat suatu objek dengan 

data GPS, atau bisa juga menggambarkan sebaran objek secara acak (random). Pada contoh kali ini, kita 

akan membuat sebaran kasus suspek difteri dengan membuat peta titik (point/dot). Adapun langkahnya 

adalah sebagai berikut: 

1. Nonaktifkan terlebih dahulu layer Cakupan DPT3 Banten dengan klik pada kotak disamping layer, 

maka tanda centang pada kotak akan hilang. 

2. Copy layer Cakupan DPT3 Banten lalu klik kanan pada Layers > Paste 

  

3. Rename salah satu layer Cakupan DPT3 Banten dengan cara menekan tombol F2 pada keyboard lalu 

ubah nama layer menjadi  Kasus Difteri. 

4. Klik ganda pada layer “Kasus Difteri”, pilih tab Symbology kemudian pilih kolom Quantities > Dot 

Density 



 

5. Pada kotak Field Selection pilih Kasus Difteri,  kemudian klik tombol > (  ). Maka field Kasus 

Difterakan berpindah ke kolom di sebelah kanan. 

6. Klik ganda pada point di kolom symbol, kotak dialog Symbol Selector. Anda bisa merubah bentuk, 

warna, dan ukuran point. Klik OK. 

 

7. Tentukan nilai dot yang menandakan perwakilan dari sebuah dot pada kolom Dot Values. Apabila Dot 

Values diisi angka 10, maka artinya 1 dot mewakili 10 dot. Sedangkan bila diisi angka 1, artinya 1 dot 

bernilai 1 dot pula. Pada contoh ini, dot yang merepresentasikan kasus difteri kita beri nilai satu, 

sehingga kolom Dot Values kita isi dengan angka 1. 



 

8. Klik OK untuk memproses. Hasilnya seperti pada gambar di bawah ini. 

 
Sekarang Anda mempunyai dua buah layer yaitu layer Cakupan DPT3 Banten dan layer Kasus 

Difteri. Untuk mengkombinasikan dua layer tersebut, langkahnya adalah sebagai berikut: 

1. Aktifkan kembali layer Cakupan DPT3 Banten dengan klik pada kotak disamping layer, maka 

muncul tanda centang pada kotak. 

2. Ubah susunan layer agar tampilan pada map canvas menampilkan dua layer tersebut. Ingat, layer 

paling atas merupakan tampilan terluar dari peta yang ditampilkan pada Map Canvas. 

3. Cara mengubah susunan layer dilakukan dengan Drag-and-Drop layer yang bersangkutan. 

4. Apabila label pada peta menjadi dua, pilih salah satu layer kemudian nonaktifkan label pada layer 

dengan cara klik ganda pada layer kemudian pilih tab Labels. Hilangkan centang pada kolom 

Label features in this layer. 



 

5. Hasil layer yang telah dikombinasikan akan menjadi sebagai berikut. 

6. Simpan project dengan klik tombol Save Project (  ) pada menu toolbar di drive yang Anda 

inginkan. 

  



 

BAB IV 

LAYOUT PETA 

 

Pembuatan layout peta merupakan pekerjaan terakhir setelah input data, editing data, analisis 

data, penambahan label, dan pengaturan legenda telah dilakukan. Melalui fasilitas layout dapat 

membuat dan mengatur data mana saja yang akan digunakan sebagai output dari proses atau analisis 

GIS yang digunakan serta bagaimana data tersebut akan ditampilkan. 

Layout ini akan bermanfaat untuk memperjelas peta dan memperindah secara tampilan, selain 

itu tujuan yang lebih penting mengenai layout peta adalah sebagai atribut pelengkap yang mampu 

menjelaskan isi peta, yang merupakan informasi-informasi penting. Tanpa adanya layout, sebuah peta 

tidak akan berarti apa-apa, dan hanya bermakna sebagai gambar biasa. Pentingnya layout ini pada 

sebuah peta, sehingga perlu dilakukan pelatihan untuk meningkatkan pengetahuan dan keterampilan 

dalam mendesain layout yang baik. Melalui praktikum ini praktikan diharapkan akan mempunyai 

pengetahuan mengenai layout dan dapat mengaplikasikannya untuk keperluan lain. 

Output yang dikehendaki oleh sebagian besar user adalah layout peta yang menarik dan 

mudah dimengerti serta mengandung presisi yang baik. Setidaknya dalam suatu layout peta, seperti 

judul peta, skala peta, arah utara, koordinat/grid, legenda peta, tahun pembuatan, penerbit peta, dan 

index peta.  

4.1. Pengaturan Layout Peta Pada ArcMap 

Map Composer pada ArcMap memungkinkan Anda untuk mempersiapkan peta hingga siap untuk 

dicetak. Selain menambahkan peta, Anda juga dapat menambahkan berbagai informasi tambahan 

seperti gambar, label, legenda, dan skala. 

1. Pergi ke View > Layout View. Tampilan pada map canvas akan berubah menjadi sebuah bidang 

gambar. ArcMap akan memunculkan peta yang sudah kita buat secara otomatis kedalam bidang 

layout. 



 

2. Ubah orientasi bidang layout dengan cara klik kanan pada bidang, kemudian pilih Page and Print 

Setup 

3. Kotak dialog Page and Print Setup akan muncul. Ubah orientasi pada kolom Paper menjadi Potrait 

atau Landscape sesuai keinginan Anda. Klik OK. 

4. Sesuaikan peta dengan bidang layout dengan cara klik Zoom In (  ) atau geser peta dengan klik 

Pan (  ) pada Navigation Toolbar. 

  

 Pada menu toolbar Insert terdapat beberapa fitur yang dapat kita gunakan untuk melakukan 

layout peta. 

Icon Nama Icon Fungsi 

 

Data Frame Menambahkan elemen peta selain peta dari proyek yang 

sedang dibuat.  

 Title Menambahkan judul pada peta 

 Text Menambahkan tulisan / string pada peta 

 

Picture Memungkinkan kita untuk menambahkan gambar. Anda 

dapat menambahkan logo perusahaan atau organisasi, atau 

jika Anda hanya ingin menampilkan gambar dari lokasi peta 

tersebut.  



 

Icon Nama Icon Fungsi 

 
Add new label Menambahkan teks pada layout, seperti judul atau informasi 

lainnya. 

 

Legend Menambahkan legenda, yang akan dihubungkan dengan 

layer aktif pada jendela ArcMap. 

 North arrow Menambah tanda panah utara pada layout peta. 

 Scale Bar Menambahkan garis skala pada layout. 

 

Scale Text Menambahkan angka skala pada layout. 

 

Langkah – langkah dalam proses layout peta adalah sebagai berikut: 

1. Sesuaikan peta dengan bidang layout 

2. Klik Insert pada toolbar pilih Title (  ) untuk 

menambahkan judul peta. Pada kotak dialog Title Map, 

ketik judul yang Anda inginkan. Sebagai contoh, judul 

peta yang akan dibuat adalah “Peta Sebaran Kasus Difteri 

dan Cakupan Imunisasi DPT3 Provinsi Banten Tahun 

2017” 

3. Sesuaikan ukuran judul peta. Ubah teks, dan pengaturan 

teks dengan klik kanan pada title > Properties. 

 

4. Selanjutnya tambahkan garis skala pada peta dengan Klik Insert > Scale Bar (   ). Pada kotak 

dialog Scalebar Selector pilih model scale bar yang diinginkan. Klik Properties untuk melakukan 

pengaturan teks Scalebar. Klik OK. 

5. Elemen garis skala akan muncul pada peta. Letakkan scale bar di sebelah pojok kiri dari layout peta. 



 

 

6. Berikutnya, kita perlu menambahkan keterangan skala pada peta. Klik Insert > Scale Text (  ). 

Pada kotak dialog Scale Text Selector pilih model scale text yang diinginkan. Klik Properties untuk 

melakukan pengaturan teks pada skala. Klik OK. 

7. Elemen teks skala akan muncul pada peta. Letakkan teks skala di sebelah pojok kiri layout peta di 

atas scalebar. 

 

8. Klik Insert > North Arrow (  ). Pilih logo arah utara pada North Arrow Selector sesuai keinginan. 

9. Logo arah utara akan muncul pada peta. Sesuaikan letak logo pada peta. 



 

 
10. Tambahkan sebuah legenda sehingga pembaca peta Anda akan mengetahui apa saja yang diwakili 

oleh simbol-simbol tersebut. Klik Insert > Legend (  ). 

11. Pada Legend Wizard terdapat kolom Map Layers yang berisi layer apa saja yang digunakan dalam 

membuat peta. Pada samping kolom Map Layers terdapat kolom Legend Items yang memuat 

Legenda apa saja yang dapat dimunculkan dari layer yang ada. 

12. Pilih elemen yang penting untuk dimasukkan. Anda juga dapat melakukan pengaturan susunan 

legend dengan memilih tombol panah atas dan panah bawah pada Legend Wizard. Klik Next. 

 
13. Terdapat kolom Legend Title yang mana Anda bisa merubah judul legend dengan mengetik pada 

kolom Legend Title sesuai keinginan. Jika Anda tidak ingin merubah judul legend, Anda bisa abaikan 

kolom Legend Title untuk kemudian klik tombol Next. 



 

 
14. Selanjutnya terdapat kolom Legend Frame berisi pengaturan frame pada Legend. Jika Anda tidak 

ingin memberikan frame pada legend, Anda bisa abaikan kolom Legend Frame untuk kemudian klik 

tombol Next. 

 
15. Selanjutnya terdapat kolom untuk merubah Panjang dan lebar legend items. Abaikan langkah ini jika 

Anda tidak ingin merubahnya. Klik Next. 

16. Berikutnya terdapat kolom pengaturan jarak legend. Abaikan langkah ini jika Anda tidak ingin 

merubahnya. Klik Finish. 

17. Legend akan muncul pada peta. Sesuaikan letak legend pada peta. 



 

 

18.  Klik Insert pada toolbar pilih Text (  ) untuk menambahkan keterangan pada peta. Tambahkan 

keterangan sumber data, penyusun/pembuat peta, dan nama instansi/logo instansi. 

19. Tata letak layout peta dapat disesuaikan dengan kebutuhan atau disesuaikan dengan infromasi yang 

akan ditampilkan 

20. Ketika Anda sudah selesai, layout peta Anda akan tampak seperti ini: 

 



 

21. Terakhir, Anda dapat mencetak peta tersebut. Klik pada tombol Print/Cetak (   ) dan ikuti 

instruksi selanjutnya. 

22. Anda juga dapat menyimpan petanya dengan format JPG, JPEG, PDF PNG atau format lainnya dengan 

klik File > Export Map 

23. Pilih tempat Anda menyimpan peta yang telah dibuat, ketik nama file dan tipe file (JPEG, PDF, SVG, 

dsb). Klik Save. 
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